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Warranty Each instrument manufactured by GE Infrastructure Sensing, Inc. is 
warranted to be free from defects in material and workmanship. 
Liability under this warranty is limited to restoring the instrument to 
normal operation or replacing the instrument, at the sole discretion of 
GE Infrastructure Sensing, Inc. Fuses and batteries are specifically 
excluded from any liability. This warranty is effective from the date of 
delivery to the original purchaser. If GE Infrastructure Sensing, Inc. 
determines that the equipment was defective, the warranty period is:

• one year for general electronic failures of the instrument

• one year for mechanical failures of the sensor

If GE Infrastructure Sensing, Inc. determines that the equipment was 
damaged by misuse, improper installation, the use of unauthorized 
replacement parts, or operating conditions outside the guidelines 
specified by GE Infrastructure Sensing, Inc., the repairs are not 
covered under this warranty.

The warranties set forth herein are exclusive and are in lieu of
all other warranties whether statutory, express or implied
(including warranties of merchantability and fitness for a
particular purpose, and warranties arising from course of
dealing or usage or trade).

Return Policy If a GE Infrastructure Sensing, Inc. instrument malfunctions within the 
warranty period, the following procedure must be completed:

1. Notify GE Infrastructure Sensing, Inc., giving full details of the 
problem, and provide the model number and serial number of the 
instrument. If the nature of the problem indicates the need for 
factory service, GE Infrastructure Sensing, Inc. will issue a RETURN 
AUTHORIZATION number (RA), and shipping instructions for the 
return of the instrument to a service center will be provided.

2. If GE Infrastructure Sensing, Inc. instructs you to send your 
instrument to a service center, it must be shipped prepaid to the 
authorized repair station indicated in the shipping instructions.

3. Upon receipt, GE Infrastructure Sensing, Inc. will evaluate the 
instrument to determine the cause of the malfunction.

Then, one of the following courses of action will then be taken:

• If the damage is covered under the terms of the warranty, the 
instrument will be repaired at no cost to the owner and returned.

• If GE Infrastructure Sensing, Inc. determines that the damage is not 
covered under the terms of the warranty, or if the warranty has 
expired, an estimate for the cost of the repairs at standard rates 
will be provided. Upon receipt of the owner’s approval to proceed, 
the instrument will be repaired and returned.
iii
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Introduction This chapter provides instructions for entering the programming data 
required to place the CTF878 flowmeter into operation. Before the 
CTF878 can begin taking measurements and displaying valid data, 
the current system and pipe parameters must be entered. Additional 
programming options provide access to the more advanced features of 
the CTF878, but this information is not required to begin taking 
measurements.

Powering UP Immediately upon power up the CTF878 emits a short beep and 
displays a “PCI Loader” message. It then validates the instrument 
programming, and displays the GE Sensing logo and the software 
version. If the meter fails any of these tests, contact the factory.

After the meter conducts all the self checks, the screen then appears 
similar to the one shown in Figure 1-1 below.

Figure 1-1: Screen After Powering ON
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Using the Screen The essential features for operating the CTF878 are the screen and 
keypad. Although these features are common, the CTF878 design 
offers particular features to simplify and speed operation. The new 
menu system is very user-friendly; program information is now 
located on tabbed forms instead of on a long, linear menu.

The primary function of the screen is to display information in order 
for you to take measurements accurately and easily. The CTF878 
screen consists of those parts shown in Figure 1-2 below.

Figure 1-2: CTF878 Screen in Operate Mode

The top line of the screen is the status bar, which normally displays 
the time and date. However, when you press [MENU] (the menu key), 
the menu bar replaces the status line.  

The middle of the screen is the work area, which displays the 
measured parameters, numeric measurements, and both bar and line 
graphs. When you enter a selection on the menu bar, this area displays 
menu prompts. A line at the bottom of the area also displays error 
code messages, which are described in more detail in the Service 
Manual.

E1: Receiver
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Using the Screen (cont.) The system tray displays icons that indicate meter operations not 
otherwise shown. Table 1-1 below lists the icons and their meanings.

The bottom of the screen displays the three function key options: F1, 
F2 and F3. These keys have different functions, depending on the task 
being performed. The initial, factory setup, configuration for these 
keys is as follows:

• F1 = Transducer

• F2 = Diagnostics

• F3 = Save Now

Table 1-1:  Icons in the System Tray
Icon Function Meaning

Alert The meter encountered an error 
in operation.

Log A log is running (marks).

Log A log is pending (no marks).
Programming Site Data 1-3
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Using the Keypad The CTF878 keypad contains 24 keys that are labeled with their 
functions. The complete keypad is illustrated in Figure 1-3 below and 
a detailed description of the functions for each of the 24 keys is listed 
in Table 1-2 on page 1-5.

Figure 1-3: CTF878 Keypad
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Using the Keypad (cont.)
Table 1-2:  CTF878 Key Functions

Key Function
Software Function Keys: Press to select the 
special functions displayed directly above them 
at the bottom of the screen.

12 Numeric Keys: Use to enter numeric data.

Arrow Keys: Press to scroll through function 
choices in measurement mode or to scroll 
through menu choices in programming mode. 
Press [<] as a backspace key in programming 
mode.

Help Key: Use to access on-line help. See the 
next section for details.

Escape Key: Press to exit menus or menu 
options at any time, or cancel a numeric entry.

Select Key: Use to move between data 
measurements on the screen.

Menu Key: Press to access the Main Menu.

Enter Key: Use to enter a particular menu or to 
enter selected values into CTF878 memory.
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3 4
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7 8

9 0
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Entering the Program 
Menu

To enter the Program Menu, press the [MENU] key at the lower right of 
the CTF878 keypad. The Menu Bar replaces the Status Bar at the top 
of the screen. Press the  [ ] arrow key once to scroll from the Site 
Menu to the Program Menu. At the Program Menu, press [ENTER]. 
The screen appears similar to Figure 1-4 below. While following the 
programming instructions, see the Program Menu Map, Figure 1-34 
on page 1-37.

Figure 1-4: Program Menu

To scroll to a particular option, press the [ ]or [ ] arrow keys until 
you reach the option. Then press [ENTER] to open the option window.

When entering parameters in an option, press:

• The  [ ] key to step through the available parameters 

• The [ ] key to scroll back to a previously entered parameter

• The [F2] key (Cancel) or the [ESC] key to exit an option at any time 
and return to Operate Mode without changing the parameters.

Note: The Transducer, Pipe, Fluid and Path parameters are 
categorized under the same Transducer/Pipe menu, as shown 
in Figure 1-5 below. You can be more time-efficient by 
programming the parameters in all four entries under 
Transducer/Pipe before exiting the menu.

When you are highlighting a parameter in one of the four entries, and 
you wish to go to another entry:

1. Use the [ ] key to scroll up to the current tab (the entry that you 
are under).

2. Press the [ ] or [ ] key to select the parameter you want to 
access, then press [ENTER].

Site                       Meter    Logging    Service

Pipe
Fluid
Path

IO

Standard Volume
User Functions
Correction Factors

0 50 100

Program
Transducer elocity, m/s

Cross Corr
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Entering Transducer 
Parameters

To enter the Transducer option, scroll to the Transducer tab on the 
Program Menu and press [ENTER]. The screen appears similar to 
Figure 1-5 below. To step through each parameter, press the [ ] key. 
Refer to the Program Menu Map, Figure 1-34 on page 1-37.

Note: If the CTF878 does not scroll to a particular parameter, the 
parameter is not necessary for that transducer type.

.

Figure 1-5: Transducer Option Window

The next prompt asks you to enter the transducer number (printed on 
the transducer itself), or to specify that you are using a special 
application transducer.

1. From the Type prompt, press the [ ] key to reach the Transducer 
prompt, and press [ENTER].

2. A drop-down list of transducer numbers opens (see Figure 1-6 
below). Press the [ ] or [ ] keys to scroll to the appropriate 
number, or scroll to “Special” for a special application transducer.

3. Press [ENTER] to confirm your selection.
.

Figure 1-6: Transducer Type Options
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OKCancel
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TransducerTransducer Pipe Fluid Path

SPECIAL
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OKCancel
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Entering Transducer 
Parameters (cont.)

Upon your selection, a warning screen appears similar to Figure 1-7 
below. In three out of four warnings, the Receiver Board option 
number appears as part of the text.

IMPORTANT: If SPECIAL is selected as the transducer type, a 
number does not appear, however, the warning still 
states that the transducer selection must match the 
Receiver Board.

Figure 1-7: Transducer Selection Warning Screen

The Receiver Board option number corresponds to the frequency 
range selected with the original order (see Table 1-3 below).

4. Compare the Receiver Board option number listed on the 
WARNING screen with the one assigned to your CTF878. 

Note: The Receiver Board option number is the last digit of the 
IGM878’s model number. That model number can be found on 
the label attached to the inside of the front cover. In 
Figure 1-8 below the Receiver Board option number is 3.

Figure 1-8: Transducer Type Options

Table 1-3:  Frequency Options

Option No. Frequency Range

3 1 MHz / 888 KHz

4 500 KHz / 471 KHz

5 250 KHz / 222 KHz

T

z

OK

This transducer selection requires 
a matching Option 3 (1000/888 
kHz) Receiver Board. See manual 
for details.

Transducer/Pipe
* * * WARNING * * *

GE Infrastructure Sensing

Model No:
Serial No:

Volts:

CTF878-1-11-XXXX2X
XXX
85-264 VAC

Made in USA

20Watts:

3
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Entering Transducer 
Parameters (cont.)

The program now varies, depending on whether you have selected 
typical or special transducers.

• If you have selected a typical transducer, the CTF878 comes 
programmed with the needed parameters. Proceed to 
Parameters for Typical Transducers below.

• However, if your application requires entering a special 
transducer / receiver option, go to the next section, Parameters 
for Special Transducers on page 1-9.

Parameters for Typical 
Transducers

If a typical transducer has been selected, the user must:

1. Enter the transducer wedge temperature (Wedge Temp) text box 
and press [ENTER].

2. Type in the value (provided by the factory) and press [ENTER].

3. Proceed to Entry Confirmation on page 1-10.

Parameters for Special 
Transducers

Note: The factory will supply the information required below with a 
special transducer / receiver option.

The user must enter the appropriate transducer / receiver operating 
frequency range.

IMPORTANT: The CTF878 flowmeter and the transducers have the 
same fixed frequency band of operation defined by 
the customer's application. The frequency printed on 
the transducers represents a frequency band of 
operation and does not always match the up or down 
frequencies.

1. From the Transducer prompt, press the [ ] key to reach the 
Frequency Up (Frq Up) prompt, and press [ENTER].

2. A drop-down list of thirty-six frequencies opens, ranging from 
0.222 to 8.00 MHz. Scroll to the correct frequency, and press 
[ENTER].

3. Repeat the same selection process for the Frequency Down 
(Frq Dn) prompt.

Next, you must enter the transducer wedge angle (Wedge Ang) and 
wedge soundspeed (Wedge SS).

4. Scroll to the appropriate text box and press [ENTER].

5. Type in the value (provided by the factory).

Note: If you enter an incorrect numeric value, press the [ ] key to 
erase the last digit entered.

6. Once the value has been entered, press [ENTER] and proceed to 
Entry Confirmation below.
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Entry Confirmation • To confirm the entries and return to Operate mode, press [F3] (OK). 

• To leave the window without confirming the entries, press [F2] 
(Cancel) or the [ESC] key.

In either case, the CTF878 returns to Operate Mode.

Entering Pipe 
Parameters

To enter the Pipe option, scroll to the Pipe tab on the Program Menu 
and press [ENTER]. (From the Transducer window, you can scroll back 
up to the Transducer tab and press the  [ ] arrow key to reach the 
Pipe window, and press [ENTER].) The screen appears similar to 
Figure 1-9 below. To step through each parameter, press the [ ] key. 
See the Program Menu Map, Figure 1-34 on page 1-37.

Note: Refer to the installation reference Sound Speeds and Pipe Size 
Data (914-004) for additional information about pipe sizes 
and sound speeds.

Figure 1-9: Pipe Option Window

Pipe
Transducer Fluid Path

Other

5

Material

OKCancel

OD, mm
15.71

ODxPI, mm Wall, mm
2

Sound Speed 600 m/s

Transducer/Pipe

Pipe
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Entering Pipe 
Parameters (cont.)

1. The first prompt asks you to select the pipe material.

a. Press [ENTER] to enter the material prompt.

b. A drop-down list of materials opens as shown in Figure 1-10 
below. Press the [ ] or [ ] keys to scroll to the appropriate 
material, or scroll to “Other” for a material not on the list. Press 
the  [ ] key to scroll down by a page, or the [ ] key to scroll 
up by a page.

c. Press [ENTER] to confirm the choice.

Figure 1-10: Pipe Material Options

Transduc
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Steel (1% Carbon)
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Steel (Carbon)
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Inconel
Iron (Armco)
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Iron (Ductile)
Iron (electrolytic)
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Steel (Stainless 316)
Steel (Stainless 304L)
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Plastic (CPVC)OD, mm
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Tungsten, carbide

Tin, rolled
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Plastic (Polypropylene)
Plastic (PVC)
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Other

Transducer/Pipe
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Transducer/Pipe

Transducer/Pipe
Other
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Entering Pipe 
Parameters (cont.)

Figure 1-11: Pipe Option Window

2. For pipe diameter, two alternatives are available. The meter asks 
for the pipe outside diameter (OD) and wall thickness (Wall). But if 
you have selected certain pipe materials (carbon or stainless steel, 
cast iron, PVC and CPVC), you have the option of entering the 
pipe dimensions by a standardized schedule. Once you enter the 
nominal pipe size (Nominal) and identification (Schedule), the 
CTF878 determines the OD and wall thickness from an internal 
table.

If you want to use the diameter alternative (available for all 
materials): 

a. You must select from two choices, outside diameter or 
circumference.

• The prompt moves to the outside diameter (OD) text box. 
Type the OD (in mm or in., whichever is displayed) into the 
box, and press [ENTER] to confirm your choice,

or
• Move the prompt to the circumference (ODxPI) text box. Type 

the circumference (in mm or in., whichever is displayed) into 
the text box, and press [ENTER] to confirm the choice.

b. In either case, the next prompt asks for the wall thickness. Type 
the value (in mm or in., whichever is displayed) into the box, 
and press [ENTER] to confirm your choice.

Note: The measurement units shown depend on the choices made in 
the English/Metric window or the Meter Settings menu. You 
can, however, change the measurement units in any text box by 
moving to that box and pressing the F1 key.

Pipe
Transducer/Pipe

PipeTransducer Fluid Path

OtherMaterial

OKCancel

OD, mm
15.71

ODxPI, mm Wall, mm
2

Pipe

English

Sound Speed 600 m/s

Transducer/Pipe

5
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Entering Pipe 
Parameters (cont.)

     If you select a material that has the Schedule option, and you wish
     to use that alternative:

a. The prompt asks if you wish to apply ANSI (the ANSI 
schedule). Press [ENTER] to select (or deselect) the ANSI box.

Note: Selecting the ANSI box enables you to use the Schedule 
alternative

b. Press the [ ] key twice to move the prompt to the Nominal 
pipe size drop-down menu. Press [ENTER] to open the menu. 
Scroll to the desired pipe size, and press [ENTER] to confirm 
your choice.

c. Press the [ ] key to move the prompt to the Schedule drop-
down menu. Press [ENTER] to open the menu. Scroll to the 
desired schedule,  and press [ENTER] to confirm the choice.

• To confirm the entries and return to Operate Mode, press [F3] 
(OK). 

• To leave the window without confirming the entries, press [F2] 
(Cancel) or the [ESC] key.

In either case, the CTF878 returns to Operate Mode.
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Entering Fluid Types and 
Speeds

To access the Fluid option, scroll to the Fluid entry on the Program 
Menu and press [ENTER]. (If you are already in the Transducer/Pipe 
form, press the  [ ] arrow key to reach the Fluid window, and press 
[ENTER].)The screen appears similar to Figure 1-12 below. To step 
through each parameter, press the [ ] key. Refer to the Program 
Menu Map, Figure 1-34 on page 1-37.

Figure 1-12: Fluid Type Options

To select the fluid:

1. Press [ENTER] to open the drop-down menu.

2. Use the [ ] key to scroll to the appropriate option.

3. Press [ENTER] to confirm your selection.

Note: If you select Air or Natural Gas, the meter sets the soundspeed 
and suggests a value for K/V x 10-6. If you wish, you can 
change the value of K/V x 10-6.

If you select Other, you must enter values for Sound Speed 
and for K/V x 10-6 (see Installation Reference #914-004, 
Sound Speeds and Pipe Size Data).

Transducer Pipe Path

OtherFluid

K/V x 10 m  /s

OKCancel

14.607

Transducer Pipe Fluid Path

Fluid

OKCancel

Air

Other

Natural Gas

-6 2

Sound Speed 600 m/s

Sound Speed

K/V x 10-6

Transducer/Pipe

Fluid
Transducer/Pipe

Other
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Entering Fluid Types and 
Speeds (cont.)

• To confirm the entries and return to Operate Mode, press [F3] 
(OK). The CTF878 returns to Operate Mode. 

• To leave the window without confirming the entries, press [F2] 
(Cancel) or the [ESC] key. The CTF878 returns to Operate Mode.

Entering Path 
Parameters

To enter the Path option, scroll to the Path tab on the Program Menu 
and press [ENTER]. (From the Fluid window, you can scroll back up to 
the Fluid tab, and press [ENTER].) The screen appears similar to 
Figure 1-13 below. To step through each parameter, press the [ ] 
key. Refer to Program Menu Map, Figure 1-34 on page 1-37.

Figure 1-13: Path Window

Transducer Pipe Fluid

Tag Path

OKCancel

152.4 mm

Txdr Spacing 69.85 mm

Transducer/Pipe

Path
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Path Parameters for 
Clamp-On Transducers

The CTF878 path menu includes two parameters:

• TAG Path

• Transducer Spacing

The TAG Path is calculated from the data entered in the Pipe 
parameters under Program. It can be overwritten if the user wants to 
use a value other than the one calculated by the flowmeter. However, 
it must always match the TAG Path set on the clamping fixture for 
reliable operation. If the path is changed on the instrument and on the 
clamping fixture, it must be within ±10% of the original TAG Path 
calculated by the flowmeter.

The Transducer Spacing is calculated from the data entered in the 
Transducer/Pipe/Fluid parameters. The value of Transducer Spacing 
is NOT used in the flowmeter’s data processing, unlike the Tag Path. 
Do not attempt to change the Transducer Spacing in the instrument. 
It is only an output intended to tell the user the distance to be set 
between a Transmitter and a Receiver for optimal signal transmission.

Figure 1-14:  Typical Clamping Fixture/Transducer Setup

UPSTREAM

UPSTREAM DOWNSTREAM

DOWNSTREAM

CLAMPING
FIXTURE

PIPELINE
(no taps)

TAG PATH

TRANSDUCER

SPACING

FLOW

RECEIVER RECEIVER

TRANSMITTER
TRANSMITTER
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Entering Analog Inputs The Analog Input option enables you to specify parameters for 
general purpose inputs. To enter the Inputs option, scroll to the 
Input/Output (IO) entry on the Program Menu and press [ENTER]. The 
screen appears similar to Figure 1-15 below. To step through each 
parameter, press the [ ] key. Refer to the Program Menu Map, 
Figure 1-36 on page 1-39.

Figure 1-15: Input/Output Option Window

Note: Input/Output Menu options may appear in a different order, 
depending on where each option card is installed. Cards are 
numbered from right to left. The number shown in parentheses 
is the option card slot number.

1. Scroll to AnalogIns and press [ENTER] to confirm your selection. 
Another drop-down menu as in Figure 1-16 below appears.

Figure 1-16: Analog Inputs Option Window
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Entering Analog Inputs 
(cont.)

2. Use the [ ] key and [ENTER] to select an AnalogIn. At the next 
prompt, name the input Function by selecting one of four options: 
Off, Pressure, Temperature or Special (see Figure 1-17 below).

Note: The units for pressure and temperature are based on the 
settings in the Meter/Units menu.

Figure 1-17: Function Menu Options

3.  The next prompt asks you to create a name for a special function, 
if desired (see Figure 1-18 below).

Figure 1-18: Analog Input Information

4-20 In Setup

Off
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Units

Function

OKCancel

Pressure
Temperature

Label

Special

4-20 In Setup

Off

Off

Special
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Zero

Units

Function

OKCancel
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Entering Analog Inputs 
(cont.)

a. Press [ENTER] to enter the text box. The text creation window 
appears, as shown in Figure 1-19 below.

Figure 1-19: Text Creation Window

b. Use the four arrow keys to scroll to the desired letter or 
symbol, and press [ENTER] to add the letter to the name.

Note:  Pressing [SEL] causes the screen to show successively a set of 
upper-case (capital) letters, a set of lower-case letters, and a 
set of symbols. Use all three screens to create a desired label.

c. Repeat this procedure for each letter or symbol you wish to add 
to the name (up to a total of eight characters). If you wish to 
delete a letter, press [F1] (Delete) to erase each letter or symbol, 
from right to left on the label.

d. When you have completed the label, press [F3] (OK) to confirm 
the label, or [F2] (Cancel) to leave the window without adding 
the label.

4. The next three prompts ask for the function units, the zero input 
value, and the span input value. For each prompt:

a. Press [ENTER] to enter the text box.

b. Use the numeric keys to enter the desired value.

c. Press [ENTER] to confirm the entry.

You have completed entering data for general-purpose inputs.

• To confirm the entries and return to Operate Mode, press [F3] 
(OK). The CTF878 returns to Operate Mode. 

• To leave the window without confirming the entries, press [F2] 
(Cancel) or the [ESC] key. The CTF878 returns to Operate Mode.
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Entering Analog Outputs The Analog Output option enables the set up of additional output 
parameters. To enter the option, scroll to the Analog Output entry on 
the Program Menu (see Figure 1-20 below) and press [ENTER].

Note: Input/Output Menu options may appear in a different order, 
depending on where each option card is installed. Cards are 
numbered from right to left.

Figure 1-20: Analog Output Option Window

The screen appears similar to Figure 1-21 below. To step through 
each parameter, press the [ ] key. See the Program Menu Map, 
Figure 1-35 on page 1-38.

Figure 1-21: Analog Output Window
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Entering Analog Outputs 
(cont.)

1. The first prompt enables you to select a range to send a current 
signal to a recording device (see Figure 1-22 below). 

a. Press [ENTER] to open the drop-down menu.

b. Scroll to the desired output from three choices: Off, 0-20 mA, 
and 4-20 mA.

c. Press [ENTER] to confirm your selection.

Note: If you select “Off,” you will not be able to access any other 
parameters in this option.

Figure 1-22: Analog Out Selection Window

2. Scroll to the next prompt and select the Data Source measurement 
type from a list of choices (see Figure 1-23 on page 1-22).

a. Press [ENTER] to open the window.

b. Scroll to the desired output type.

c. Press [SEL] to confirm your selection.

d. The prompt then moves to a list of unit types. (The available 
units depend on the selection made at the Data Source prompt.) 
Scroll to the desired output unit.

e. Press [F3] (OK) to confirm your selection.

3. The next prompt requests the zero (base) value for the analog 
output. This value represents the 0/4 mA output (in flow units).

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the desired value.

c. Press [ENTER] to confirm your selection.

Span
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OKCancel

Analog Out

Hold LastOn Error

100

Off

0ma-20ma
4ma-20ma

Off

4-20 Out Setup
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Entering Analog Outputs 
(cont.)

Figure 1-23: Data Source Selection Window

4. The next prompt requests the span (full scale) value for the analog 
output. This value represents the 20 mA output (in flow units).

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the desired value.

c. Press [ENTER] to confirm your selection.

5. The last prompt, On Error, asks you to select how the CTF878 will 
handle the analog outputs in the event of a fault condition. The 
meter offers three alternatives:

• Hold Last Value (hold the last good reading)

• Force Low (force the reading to 0 or 4 mA)

• Force High (force the reading to 20 mA).

a. Press [ENTER] to open the drop-down menu.

b. Scroll to the desired selection.

c. Press [ENTER] to confirm your selection.

You have completed entering data in the Analog Output option.

• To confirm the entries and return to Operate mode, press [F3] (OK). 
The CTF878 returns to Operate Mode.

• To leave the window without confirming the entries, press [F2] 
(Cancel) or the [ESC] key. The CTF878 returns to Operate Mode.

OKCancelNo Unit

AuxIn
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Volume
Fwd Totalizer
Rev Totalizer

Temperature

m/sDIAG

StdFwd Totalizer

Select Measurement

Velocity
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Entering Digital Outputs While resembling the Analog Output option, the Digital Output 
option enables you to set up parameters necessary for a digital output. 
To enter the option, scroll to the Digital Output entry on the 
Program / IO / Freq/Tot Menu and press [ENTER].

Note: Input/Output Menu options may appear in a different order, 
depending on where each option card is installed. Cards are 
numbered from right to left.

The screen appears similar to Figure 1-24 below. To step through 
each parameter, press the [ ] key. Refer to the Program Menu Map, 
Figure 1-36 on page 1-39.

Figure 1-24: Digital Output Window

1. The first prompt enables you to select the output function from 
three choices: Off, Pulse Totalizer, Frequency

a. Press [ENTER] to open the drop-down menu.

b. Scroll to the desired function.

c. Press [ENTER] to confirm your selection.

Note: If you select Off, you will not be able to access any other 
parameters in this option.
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m

OKCancel
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3

3
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Programming Site Data 1-23



February 2007
Entering Digital Outputs 
(cont.)

2. The next prompt asks you to select the data source for the digital 
output. The choices vary with the function. For Pulse Totalizer 
(see Figure 1-24 on page 1-23), the available choices include:

• Forward Totalizer

• Reverse Totalizer

• Standard Forward Totalizer

• Standard Reverse Totalizer

a. Press [ENTER] to open the data source selection window.

b. Scroll to the desired source.

c. Press [SEL] to confirm your selection.

d. The prompt then moves to a list of unit types. (The available 
units depend on the selection made at the Data Source prompt.) 
Scroll to the desired output unit.

e. Press [F3] (OK) to confirm your selection.

3. The last set of parameters that appears depends on the selection 
you made at the Function prompt.

If you selected Pulse Totalizer:

The prompt asks for the units/pulse and the pulse width (in 
microseconds). (Figure 1-24 on page 1-23 illustrates a Digital Output 
window configured for the Pulse Totalizer function.) For the Units/
Pulse and Pulse Width parameters:

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the desired value.

c. Press [ENTER] to confirm your selection.

If you selected Frequency:

The prompt asks for the minimum and maximum value for the 
category and units selected and the minimum and maximum 
frequency. For each parameter:

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the desired value.

c. Press [ENTER] to confirm your selection.
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Entering Alarm 
Parameters

The Alarms option enables you to enter parameters necessary to set 
up alarms. To enter the option, scroll to the Alarms entry on the 
Program / IO Menu and press [ENTER].

Note: Input/Output Menu options may appear in a different order, 
depending on where each option card is installed. Cards are 
numbered from right to left.

The screen appears similar to Figure 1-25 below. To step through 
each parameter, press the [ ] key. Refer to the Program Menu Map, 
Figure 1-36 on page 1-39.

Figure 1-25: Alarm Setup Window

1. The first prompt enables you to select the function from four 
choices: Disabled, High, Low, and All Faults.

a. Press [ENTER] to open the drop-down menu.

b. Scroll to the desired function.

c. Press [ENTER] to confirm your selection.
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OKCancel

Function

Trigger Point 2500

Velocity
m/s
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Entering Alarm 
Parameters (cont.)

2. Scroll to the next prompt and select the Data Source measurement 
type from a list of choices (see Figure 1-26 below).

a. Press [ENTER] to open the window.

b. Scroll to the desired output type.

c. Press [SEL] to confirm your selection.

d. The prompt then moves to a list of unit types. (The available 
units depend on the selection made at the Data Source prompt.) 
Scroll to the desired output unit.

e. Press [F3] (OK) to confirm your selection.

Figure 1-26: Data Source Selection Window

3. Scroll to the next prompt and press [ENTER] to select or deselect the 
Failsafe option. If Failsafe is selected, an X will appear in the box.

4. The next prompt asks for the Trigger Point frequency:

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the desired value.

c. Press [ENTER] to confirm your selection.
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Entering Standard 
Volume Data

The Standard Volume option enables you to set base measurements 
and specific values for pressure and temperature inputs and to select 
the corresponding option cards. To enter this option, scroll to 
Standard Volume on the Program Menu and press [ENTER].

Entering Settings The screen appears similar to Figure 1-27 below. To step through 
each parameter, press the [ ] key. Refer to the Program Menu Map, 
Figure 1-34 on page 1-37.

Figure 1-27: Standard Volume Window - Settings

1. The first prompt allows you to enable or disable the Standard 
Volume settings.

a. Use the arrow keys to move to the appropriate choice.

b. Press [ENTER] to confirm your choice.

Note: If you selected Enabled, continue on to step 2 to enter values 
for the three categories. If you selected Disabled, you will not 
be able to access the three boxes or the Inputs entry.

2. To enter numbers for the three categories:

a. Press the [ ] key to move from one box to the next.

b. Press [ENTER] and use the number keys to enter a value for 
each category.

c. Press [ENTER] to confirm each entry.

Inputs

1.01Base Pressure

OKCancel

Enabled Disabled
Standard Volume

Bar

Atmospheric Pressure Bar1.01

Base Temperature °F60

Standard Volume

Settings
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Entering Inputs Note: You can access the Inputs entry only if you selected Enabled 
for Standard Volume under the Settings tab.

Use the arrow keys to move to the Inputs tab and press [ENTER] to 
confirm your selection. The screen appears similar to Figure 1-28 
below. Use the [ ] key to move from one line to the next. Refer to 
the Program Menu Map, Figure 1-34 on page 1-37.

Figure 1-28: Standard Volume Window - Inputs

1. The first prompt allows you to fix the Pressure value or to render it 
active.

a. Use the arrow keys to move to the appropriate choice.

b. Press [ENTER] to confirm your choice.

Note: If you selected Fixed, continue on to step 2 to enter a value for 
the pressure. If you selected Active, you will not be able to 
enter the Pressure box and must proceed to step 3.

2. To enter a value for the pressure:

a. Press the [ ] key to move to the Pressure box.

b. Press [ENTER] and use the number keys to enter a value for the 
pressure.

c. Press [ENTER] to confirm your entry.

Settings

OKCancel

Fixed Active
Pressure

Pressure Bar1.0132 2:A
Input #

°FTemp

Temperature

60

Fixed
Input #
2:A

Active

Standard Volume
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Entering Inputs (cont.) 3. To designate an option card number:

a. Use the arrow keys to move to the Input # box.

b. Press [ENTER] to open a scroll-down menu.

c. Use the  key to scroll to the appropriate value and press [ENTER] 
to select the appropriate option card number.

4. The next prompt allows you to fix the Temperature value or to 
render it active.

a. Use the arrow keys to move to the appropriate choice.

b. Press [ENTER] to confirm your choice.

Note: If you selected Fixed, continue on to step 5 to enter a value for 
the temperature. If you selected Active, you will not be able to 
enter the Temp box and must proceed to step 6.

5. To enter a value for the temperature:

a. Press the [ ] key to move to the Temp box.

b. Press [ENTER] and use the number keys to enter a value for the 
temperature.

c. Press [ENTER] to confirm your entry.

6. To designate an option card number:

a. Use the arrow keys to move to the Input # box.

b. Press [ENTER] to open a scroll-down menu.

c. Use the  key to scroll to the appropriate value and press [ENTER] 
to select the appropriate option card number.
Programming Site Data 1-29



February 2007
Entering User Functions User functions enable you to program mathematical equations on 
each measurement. You can also use any parameter in the meter to 
calculate a different parameter. To enter the User Functions option, 
scroll to the User Functions entry on the Program Menu and press 
[ENTER]. The screen appears similar to Figure 1-29 below.  To step 
through each parameter, press the [ ] key. Refer to the Program 
Menu Map, Figure 1-34 on page 1-37.

Figure 1-29: User Function Window

1. The first prompt requests the function number, 1 through 8.

a. Press [ENTER] to open the drop-down menu.

b. Scroll to the desired function number (User1, User2, etc.).

c. Press [ENTER] to confirm the entry.

2. The next prompt asks you to create a label for the function.

Note: The label corresponds to the measurement type (i.e., velocity 
or temperature), the units symbol corresponds to the 
measurement units (i.e., feet/sec or degrees F), and the Dec. 
option elects the number of decimal places.

DoneCancel

0

Function

Label

Units Sym

Dec.

Delete

Set User Function

User1
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Entering User Functions 
(cont.)

a. Press [ENTER] to open the text creation window, which appears 
similar to Figure 1-30 below.

Figure 1-30: Text Creation Window

b. Use the four arrow keys to scroll to the desired letter or 
symbol, and press [ENTER] to add the letter to the label.

Note:  Pressing [SEL] causes the screen to alternate between 
upper-case (capital) letters, lower-case letters, and symbols. 
You may use any or all of the three screens to create a label.

c. Repeat this procedure for each letter or symbol you wish to add 
to the label. If you wish to delete a letter, press [F1] (Delete) to 
erase each letter or symbol, from right to left on the label.

d. When you have completed the label, press [F3] (OK) to confirm 
the label, or [F2] (Cancel) to leave the window without adding 
the label.

3. The next prompt asks for the Units Symbol. 

a. Press [ENTER] to reopen the text creation window. 

b. Repeat the procedure used for the Label (above) to create the 
Units Symbol.

c. When you have completed the entry, press [F3] (OK) to confirm 
the symbol, or [F2] (Cancel) to leave the window without 
adding the symbol.

4. The next prompt asks you to select the number of decimal places.

a. Press [ENTER] to open the drop-down menu.

b. Scroll to the desired number of decimal places, ranging 0 to 4.

c. Press [ENTER] to confirm the entry.
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Entering User Functions 
(cont.)

5. The final prompt asks for the function itself.

a. Press [ENTER] to open the function creation window, which 
appears similar to Figure 1-31 below.

b. Use the four arrow keys to scroll to the desired function or 
table, and press [ENTER] to confirm each entry. Use the numeric 
keys to enter numeric values. Press [F1] (Delete) to remove any 
mistaken or unwanted symbols or numbers.

Note: Pressing [SEL] causes the screen to alternate between a set of 
symbols and functions and a list of user functions. Use both 
screens to create the desired function.

Figure 1-31: Function Creation Window

c. To enter a particular measured parameter into the equation, 
click on the MODE symbol near the middle of the third row. 
The Select Measurement window (shown in Figure 1-23 on 
page 1-22) opens. Select the desired data source and unit (see 
page 1-23), and press [F3] (OK) to confirm the entry.

d. When you have completed entering the function, press [F3] 
(OK) to confirm the entry and return to the User Function 
window.

6. GE Sensing recommends pressing [F2] (Check) to test the validity 
of the function. The CTF878 displays either “OK” or a message 
such as “Syntax Error.”

• Press [F1] to delete the entire function, or

• Press [F3] (Done) to confirm the function and return to Operate 
Mode.
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Entering a Calibration 
Factor

The final option in the Program Menu, Correction Factor, allows you 
to enter and modify the Calibration Factor. To enter the Correction 
Factors option, scroll to the Correction Factors entry on the Program 
Menu and press [ENTER]. The screen appears similar to Figure 1-32 
below. To access the Calibration Factor, press the [ ] key. Refer to 
the Program Menu Map, Figure 1-34 on page 1-37.

Figure 1-32: Calibration Factor Window

1. To enable or disable the Calibration Factor, scroll down to the next 
line and select On or Off.

a. Use the  [  ] and [ ] keys to scroll to the appropriate option.

b. Press [ENTER] to confirm your selection.

2. If On is selected for the Calibration Factor, scroll down to choose 
a Single K-Factor or a Table of K-Factors.

a. Use the  [  ] and [ ] keys to scroll to the appropriate radio 
button.

b. Press [ENTER] to confirm your selection.

Inputs
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Meter K-Factor

OKCancel
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Single

Off
Table

Calibration Factor
K Factor

NO UNIT

Edit Table

Correction Factors
Calibration Factor
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Entering a Calibration 
Factor (cont.)

If you selected Single:

This feature enables a single multiplier to be applied to the flow rate 
reported by the CTF878.

1. Scroll down to the Meter K-Factor box.

2. Press [ENTER]  to open the text box.

3. Use the numeric keys to enter the desired value. The typical factor 
is between 0.5 and 2.00.

4. Press [ENTER] to confirm your selection.

You have completed entering data for a single Calibration Factor. 

• To confirm the entries and return to Operate mode, press [F3] (OK). 
The CTF878 returns to Operate Mode.

• To leave the window without confirming the entries, press [F2] 
(Cancel) or the [ESC] key. The CTF878 returns to Operate Mode.

If you selected Table:

The menu asks, first for the data source, and then for the entry of 
values into the Correction Factor table. This feature allows the user to 
“curve fit” velocity calibration multiple data points (from several 
different data sources or flow variables) to the flow rate reported by 
the CTF878.

Note: You must select the desired measurement and unit before you 
can enter the data table in Edit Table.

1. Scroll down to the Data Source box.

2. Press [ENTER] to open the Data Source window. The Select 
Measurement window (Figure 1-23 on page 1-22) appears.

3. Enter the desired measurement and units as described on 
page 1-22.

4. Press [F3] (OK) to confirm your selection.

5. Scroll down to Edit Table.
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Entering a Calibration 
Factor (cont.)

6. Press [ENTER] to open the table (similar to Figure 1-33 below).

Figure 1-33: KFactor Table

7. Use the four arrow keys to move to the desired entry in the table.

8. Use the numeric keys to enter the desired value for the data 
source, and press [ENTER] to confirm the entry.

9. Press the [ ] key to move to the KFactor column. Use the 
numeric keys to enter the desired value, and press [ENTER] to 
confirm the entry.

10.Repeat steps 7, 8 and 9 for the remainder of the table.

11.When you have completed entering values, press [F3] (OK) to 
confirm the table and return to the Correction Factors window.

You have completed entering data for correction factors.

• To confirm the entries and return to Operate mode, press [F3] (OK). 
The CTF878 returns to Operate Mode.

• To leave the window without confirming the entries, press [F2] 
(Cancel) or the [ESC] key. The CTF878 returns to Operate Mode.

To aid in following the programming instructions, a complete menu 
map of the User Program is included in Figure 1-34 on page 1-37, 
Figure 1-35 on page 1-38 and Figure 1-36 on page 1-39. 
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Figure 1-34: Program Menu Map - Initial Setup
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Figure 1-35: Input/Output Menu Map - Initial Setup for Analog Outputs
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Figure 1-36: Input/Output Menu Map - Initial Setup for Analog Inputs, Digital Outputs, Alarms, 
and RTDs
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Introduction The CTF878 enables the viewing of from one to four different 
measurement parameters simultaneously. The screen can show these 
parameters not only in numeric format, but as line or bar graphs as 
well.

You can configure any given measurement for your particular 
requirements. To configure an individual measurement, press [SEL] 
from the Operate Mode window. A cursor appears next to the 
parameter closest to the upper left corner. Continuing to press [SEL] 
enables the cursor to scroll through the other displayed 
measurements. Once you have reached a particular window, pressing 
the [ENTER] button opens the menu for that window, as shown in 
Figure 2-1 below. To learn how to use the display window menu, go 
to Format Option on page 2-2, View Option on page 2-3, and/or 
Limits Option on page 2-3.

] 

Figure 2-1: Display Screen After Pressing [SEL]
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Save Now
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Format Option Format, the first option on the menu, allows you to specify the type of 
notation and the number of decimal places for the measurement in 
that window. Press [ENTER] and the submenu shows two options: 
Format and Decimal Places. Press the [ ] or [ ] arrow keys to 
select either entry, and press [ENTER]. The screen appears similar to 
Figure 2-2 below. To scroll to a particular parameter or menu entry, 
press the [ ] or [ ] key.

Note: If the window displays a line or bar graph, the Measurement 
option appears instead of Format in the menu.

Figure 2-2: Number Format Window

1. The first entry, Format, asks you to select the numeric format from 
three choices: default, fixed decimal and scientific. Default 
provides the default resolution, while Fixed Decimal allows users 
to override the standard resolution. Scientific format displays the 
value in mantissa and exponent format.

a. Press [ENTER] to open the drop-down list of format choices.

b. Scroll to the appropriate selection.

c. Press [ENTER] to confirm your choice.

2. The second step asks you to choose the number of decimal places 
to be displayed. Available choices range from 0 to 4 places.

a. Press [ENTER] to open the drop-down list.

b. Scroll to the appropriate number. 

c. Press [ENTER] to confirm your choice.

3. To confirm the entries and return to Operate mode, press [F3] 
(OK). To leave the window without confirming the entries, press 
[F2] (Cancel) or the [ESC] key.

Programming
Format

OKCancel

Decimal Places

Default

Fixed Decimal
Scientific

Number Format

Default
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View Option The second option, View, allows you to select the presentation of a 
parameter in one of three formats: numeric, bar graph or line graph. 

1. From the Display Menu, press the  [ ] key once to reach the View 
option, and then press [ENTER].

2. A drop-down menu shows the three formats. Scroll to the 
appropriate selection.

3. Press [ENTER] to confirm your selection.

The screen immediately displays any changes. For example, if you 
have changed the first parameter to a line graph, the screen appears 
similar to Figure 2-3 below.

Figure 2-3: Screen After Format Change

Limits Option Once you have configured a parameter as a line or bar graph, you 
might need to change its presentation or values. The Limits option 
(replacing the Format option for line and bar graphs) enables you to 
program the minimum or maximum values displayed, the time 
interval and the display of the average value. 

To enter the Limits option:

1. Press [SEL] from the Operate Mode window until you have reached 
the desired measurement. 

2. Press [ENTER] to open the Display Menu.

3. Be sure the Limits option is highlighted, and press [ENTER]. 

4. A drop-down menu entry, Change, appears. Press [ENTER] again. 
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Limits Option (cont.) The screen appears similar to Figure 2-4 below.

Figure 2-4: Line (or Bar) Graph Parameters Window

5. The first prompt asks for the minimum value shown in the graph.

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the desired value.

c. Press [ENTER] to confirm the value.

6. Repeat the procedure in step 5 to enter the maximum value.

A line graph involves two more prompts.

7. The next prompt asks for the display interval.

a. Press [ENTER] to open the text box. Use the numeric keys to 
enter the desired number. Press [ENTER] to confirm the value.

b. The second box asks for the interval in terms of seconds, 
minutes, hours, or days. Press [ENTER] to open the drop-down 
menu, and then press the [ ] or [ ] keys to move to the 
desired parameter. Press [ENTER] to confirm the entry.

8. The final three prompts ask for details of the graph configuration: 
if you want to use lines, plot the average value, or show the 
minimum and maximum values. Press the [ ]  key to step 
through each value, and press [ENTER] to add a given detail as part 
of the graph.

9. When you have configured the graph, press [F3] (OK) to confirm 
the graph settings, or press [F2] (Cancel) to cancel the changes.

The screen returns to Operate Mode, and displays any changes.
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-10000
2-4 Displaying and Configuring Data



February 2007
Measurement Option On occasion, you might need to change the actual parameter 
measured in a given window.The Measurement option enables you to 
reconfigure the window with one of several categories of data and 
appropriate English or metric measurement units.

To enter the Measurement option:

1. Press [SEL] from the Operate Mode window until you have reached 
the measurement you want to replace. 

2. Press [ENTER] to open the Display Menu.
3. Be sure the Measurement option is highlighted, and press [ENTER]. 
The screen appears similar to Figure 2-5 below. The left column 
displays categories of data, while the right column displays English 
and metric measurement units (or, with the Diagnostics source 
shown, a list of diagnostics parameters).

4. Use the [ ] and [ ] arrow keys to reach the desired category of 
data, and press [SEL]. 

5. Then use the [ ] or [ ] arrow keys to select the desired 
measurement unit (or diagnostic parameter). Press [F3] (OK) to 
confirm the entry or press [F2] (Cancel) to cancel the changes.

6. The screen returns to Operate Mode, and displays any changes.

Figure 2-5: Measurement Menu Window
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Customizing the Display 
Screen

You might wish to display one or two parameters, or customize the 
soft keys to quickly access particular menus. The Site Menu enables 
you to make more comprehensive changes in your display screen.

To enter the Site Menu, press the [MENU] key at the lower right of the 
CTF878 keypad. The Menu Bar replaces the Status Bar at the top of 
the screen. Scroll to the Site Menu using the [ ] or [ ] key. Press 
[ENTER] or the [ ] arrow key. The screen now appears similar to 
Figure 2-6 below. While following the programming instructions, 
refer to Figure 3-13 on page 3-12.

Figure 2-6: Site Menu

• To specify the number of parameters displayed, go to page 2-7.

• To customize or clear softkeys (FKeys), go to page 2-8.

            Program    Meter    Logging    Service

Save Now
1 View
2 View
3 View
4 View
FKeys
About

100

Site Manager Diagnostics Save Now

Site
Site Manager Velocity, m/s

Cross Corr
2-6 Displaying and Configuring Data



February 2007
Specifying the Number of 
Displayed Parameters

As mentioned earlier, the CTF878 can display one to four different 
measurement parameters simultaneously. However, sometimes you 
might wish to display only one or two parameters. To change the 
number of open display windows from within the Site Menu (shown 
in Figure 2-6 on page 2-6), use the [ ]or [ ] arrow keys to move to 
the desired number of views (1 View, 2 Views, etc.). Press [ENTER].

The screen displays the designated number of windows. For
example, Figure 2-7 below shows the screen displayed in Figure 2-3 
on page 2-3, reconfigured for a single view. 

Figure 2-7: Display Screen Configured for Single View

Note: The CTF878 opens display windows from left to right and 
from top to bottom, starting from the upper left; that is, if you 
press “1 View,” the parameter displayed in the upper left 
window appears. If you press “2 Views,” the parameters 
shown in the two top windows appear. The view for “3 Views” 
adds the window in the lower left, and that for “4 Views” adds 
the window in the lower right.
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Customizing Softkeys When the screen is in Operate Mode, you might wish to access a 
particular submenu frequently without the trouble of scrolling 
through menus. Customizing the softkeys ([F1], [F2] and [F3]) allows 
you to access up to three submenus by pressing the associated 
softkey. You can customize a softkey from the Site Menu or from 
within a particular menu.

• To customize a softkey from within the Site Menu:

1. From the Site Menu (shown in Figure 2-6 on page 2-6), use the 
[ ] or [ ] arrow keys to move to the FKeys entry on the menu. 
Press [ENTER]. The screen now appears similar to Figure 2-8 
below.

Figure 2-8: FKeys Menu

2. Use the [ ] or [ ] arrow keys to move to the desired FKey 
(1, 2 or 3) entry on the menu. Press [ENTER]. The Configure FKey 
window opens, as shown in Figure 2-9 below.

Figure 2-9: Configure FKey Window
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Customizing Softkeys 
(cont.)

3. Use the [ ] or [ ] arrow keys to scroll to the desired submenu 
(for example, Site Manager).

4.  Press [ENTER] to confirm the entry, and press [F3] (OK) to confirm 
the entry and close the window. (Press [F2] (Cancel) to close the 
window without changing the key.)

The screen now appears similar to Figure 2-10 below, with the [F1] 
window displaying “Site Manager.” Pressing [F1] opens the Site 
Manager window.

• To customize a softkey from a particular menu:

1. Open the desired menu on the Menu Bar (see other chapters for 
details on particular menus) and scroll to the desired option.

2. Press the desired softkey. A window appears with the question, 
“Assign current menu command to FKeyX?”

3. Press [F3] (Yes) to confirm the assignment and close the window. 
(Press [F2] (No) to close the window without changing the key.)

Figure 2-10: Display Screen with Modified Softkey
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Customizing Softkeys 
(cont.)

• To clear a softkey:

1. From the Site Menu (shown in Figure 2-6 on page 2-6), use the 
[ ] or [ ] arrow keys to move to the FKeys entry on the menu. 
Press [ENTER]. The screen now appears similar to Figure 2-8 on 
page 2-8.

2. Use the [ ] or [ ] arrow keys to move to the desired Clear FKey 
(1, 2 or 3) entry on the menu. Press [ENTER].

The softkey window clears. You can also clear the softkey through the 
Configure FKey window, by selecting (Clear) as an entry, pressing 
[ENTER] and then [F3] (OK).

Note: Since the customized softkeys are saved globally, they will 
remain, even if you change site files.

Accessing Meter Data —
The About Option

The About option displays useful information concerning the model 
number and software version of any given CTF878. While the 
window normally appears briefly at startup, users might want to 
access the information for a longer period. To open the About 
window, scroll to the About option on the Site Menu and press 
[ENTER]. The screen appears similar to Figure 2-11 below. To access 
data on your specific CTF878, press [F2] (Next).

Figure 2-11: The About Window

To return to Operate Mode, press [ESC] or [F3] (Exit).
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Introduction As mentioned in Chapter 1, the CTF878 can store site data in files for 
current and future access. (To learn how to program setup data, refer 
to Chapter 1, Programming Site Data.) After you answer the 
necessary questions, simply save the information to a site file. The 
Site Manager option then enables you to recall, rename, revert to or 
delete site files as needed.

To open the Site Menu, press the [MENU] key at the lower right side of 
the CTF878 keypad. The Menu Bar replaces the Status Bar at the top 
of the screen. Scroll to the Site Menu using the [ ] or [ ] key. Then 
press [ENTER]. The screen now appears similar to Figure 3-1 below. To 
manage the site files, use the following instructions and refer to 
Figure 3-13 on page 3-12.

Figure 3-1: Site Menu
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Site Manager To access the Site Manager, press [MENU]. Scroll to the Site Menu 
using the [ ] or [ ] key. Then press [ENTER]. The drop-down menu 
appears. At this point, the Site Manager should be highlighted. Press 
[ENTER] to open the Site Manager window. The screen appears similar 
to Figure 3-2 below.

Figure 3-2: Site Manager Window

Note: Each CTF878 comes preprogrammed with a basic site, 
Default, which serves as a basis for saving data and creating 
other sites.

The right section of the screen supplies information for the site 
highlighted in the list on the left: its date, time and size, as well as the 
remaining amount of free memory. You can use the [ ] and [ ] 
arrow keys to scroll to a particular site and display information 
pertaining to that site.

To open the Site Manager menu, press [MENU] and then [ENTER]. The 
screen now appears similar to Figure 3-3 on page 3-3.

ExitRefresh
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Site Manager (cont.)

Figure 3-3: Site Manager Menu

Depending on the choice made, proceed to one of the following:

• Creating a New Site on page 3-4

• Opening an Existing Site on page 3-6

• Saving a Site on page 3-7

• Saving a Site with a Different Name on page 3-8

• Refreshing a Site on page 3-8

• Renaming a Site on page 3-9

• Deleting a Site on page 3-10

Arrange files from the Sort submenu (see Figure 3-12 on page 3-11.)

• Listing Files by Name on page 3-11

• Listing Files in Chronological Order on page 3-11

ExitRefresh
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Delete
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Creating a New Site Note: Be sure you have entered the necessary setup data discussed 
in Chapter 3, Programming Site Data, before creating and 
saving a new site.

To create a new site within the Site Manager, press [MENU] to open the 
File Menu. Be sure the option New is highlighted, and then press 
[ENTER]. The screen appears similar to Figure 3-4 below.

Figure 3-4: Name Entry Window for a New Site

1. Use the four arrow keys to scroll to the desired letter or number, 
and press [ENTER]. 

2. Repeat this procedure until you have created the desired site name 
of up to eight characters. Press [F1] (Delete) to remove any 
unwanted letters or numbers.

3. When you have finished, press [F3] (OK) to confirm the entry, or 
[F2] (Cancel) to leave the window without creating a site. 
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Creating a New Site (cont.) A second screen appears (see Figure 3-5 on page 3-5) asking if you 
want to use the currently highlighted site as a template, with the 
current display windows, measurements and programmed data. (To 
modify the display and measurements, refer to Chapter 2, Displaying 
and Configuring Data. To alter programming data, see Chapter 1, 
Programming Site Data.)

• Press [F2] (No) to reject it, or

• Press [F3] (Yes) to use it as a template.

Figure 3-5: Template Confirmation Window

The meter returns to Operate Mode, with the new site name displayed 
in the upper left corner of the screen.
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Opening an Existing Site If you want to return to a site you have previously saved, first 
highlight the replacement site in the left window of the Site Manager. 
Then press [MENU] to open the File Menu. Scroll to the Open option, 
and press [ENTER]. The screen appears similar to Figure 3-6 below.

Figure 3-6: Open Site Confirmation Window

• Press [F2] (No) to cancel opening the site and return to the 
current site, or

• Press [F3] (Yes) to open the site. 

If you have changed the current site, the CTF878 asks if you want to 
save the changes to the previously opened site. 

• Press [F2] (No) to cancel the changes, or

• Press [F3] (Yes) to confirm and save the changes.

The CTF878 returns to Operate Mode, with the selected site 
displayed in the upper left corner of the screen.
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Are You Sure?

Site Manager
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Saving a Site You can save the current site in one of two ways:

• From the Site Menu, you can scroll down to the Save option 
and press [ENTER], or

• From within the Site Manager, press [MENU] to open the File 
Menu, scroll to the Save option, and press [ENTER].

In either case, the screen appears similar to Figure 3-7 below.

Figure 3-7: Save Current Site Window

• Press [F2] (No) to cancel saving the site, or

• Press [F3] (Yes) to save the site.

The CTF878 remains in the current window (Operate Mode or Site 
Manager), with the current site saved.

YesNo

Save the current site (SITE03.SIT)?

Site Manager
Save SiteFi
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Saving a Site with a 
Different Name

If you want to save the current site with a different name, open the 
Site Manager, press [MENU] to open the File Menu, scroll to the 
Save As option, and press [ENTER]. The screen appears similar to 
Figure 3-8 below.

Figure 3-8: Save As (Another Name) Window

Use the four arrow keys to scroll to the desired letter or number, and 
press [ENTER]. Repeat this procedure until you have created the 
desired site name (up to eight characters long). Press [F1] (Delete) to 
remove any unwanted letters or numbers. When you have finished, 

• Press [F2] (Cancel) to erase the entry, or

• Press [F3] (OK) to confirm the entry. 

The Save Site window then appears. 

• Press [F2] (No) to cancel saving the site, or

• Press [F3] (Yes) to save the site.

The CTF878 remains in Site Manager, with the current site saved 
under both the old and new names.

Refreshing a Site You can refresh a site (updating the display with the most current 
information) in one of two ways:

• Press [F2] (Refresh) to refresh the highlighted file.

• From the File Menu, scroll to the Refresh option and press 
[ENTER].

The updated information on the highlighted file appears in the 
window on the right. However, to save the file, use the Save option.
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Renaming a Site If you want to rename a site, first be sure the site has been highlighted 
in the left window of the Site Manager. Then press [MENU] to enter the 
File Menu, scroll to the Rename option, and press [ENTER]. The screen 
appears similar to Figure 3-9 below.

Figure 3-9: Rename Site Window

Use the four arrow keys to scroll to the desired letter or number, and 
press [ENTER]. Repeat this procedure until you have created the 
desired site name. (Press [F1], Delete, to remove any unwanted letters 
or numbers.) When you have finished, 

• Press [F2] (Cancel) to erase the entry, or

• Press [F3] (OK) to confirm the entry.

The CTF878 remains in Site Manager, with the site listed under the 
new name.
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Deleting a Site To delete a site in the Site Manager, first highlight that site in the left 
window of the Site Manager. Then press [MENU] to open the File 
Menu, scroll to the Delete option, and press [ENTER]. You cannot 
delete the current (open) site. If you try, the following display appears 
(see Figure 3-10 below). Press [F3] (OK) to return to the File Menu.

Figure 3-10: Site Error Window

Otherwise, the screen appears similar to Figure 3-11 below.

Figure 3-11: Delete Confirmation Window

• Press [F2] (No) to cancel the deletion and return to the Site 
Manager, or

• Press [F3] (Yes) to delete the site.

The Site Manager appears and deletes the highlighted site.

OK

You can not delete the Current Site.
Open another site first.

Site Manager
Site ErrorFi
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Delete File 'SITE03.SIT'
Are You Sure?

Site Manager
Delete ConfirmationFi
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Listing Files by Name If you want to list your files alphabetically by site name within the 
Site Manager, press [MENU] to open the File Menu. Then press the 
[ ] arrow key to scroll to the Sort Menu (see Figure 3-12 below). 
Press [ENTER]. The Site Manager screen refreshes, with the sites listed 
in alphabetical order.

Figure 3-12: Sort Submenu

Listing Files in 
Chronological Order

To list your files chronologically by time of creation within the Site 
Manager, press [MENU] to open the File Menu. Press the [ ] arrow 
key to scroll to the Sort Menu, then scroll to the By Date option. Press 
[ENTER]. The Site Manager screen refreshes, with the sites listed in 
chronological order, from the most recent to the earliest.

ExitRefresh
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Figure 3-13: Site Menu Map
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Introduction Along with display formats and site data, CTF878 users can program 
global settings for the meter that suit their individual preferences. The 
global settings include:

• English or Metric measurement units

• Date and time parameters and appearance (locale)

• Screen contrast

• Backlight timeout

• Resetting forward and reverse totals

• User tables

Entering the Meter Menu To enter the Meter Menu, press the [MENU] key at the lower right of 
the CTF878 keypad. The Main Menu replaces the Status Bar at the 
top of the screen. Press the [ ] arrow key twice to scroll from the 
Site Menu to the Meter Menu. At the Meter Menu, press [ENTER]. The 
screen appears similar to Figure 4-1 below. While programming, refer 
to the Meter Menu Map, Figure 4-10 on page 4-14.

Figure 4-1: Meter Menu
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Entering the Meter Menu 
(cont.)

To scroll to a particular option, press the [ ] or [ ] arrow keys until 
you reach the option. Then press [ENTER] to open the option window.

When entering parameters in an option, press:

• The  [ ] key to step through the available parameters 

• The [ ] key to scroll back to a previously entered parameter

• The [F2] key (Cancel) or the [ESC] key to exit an option at any time 
and return to Operate Mode without changing the parameters.

Selecting Measurement 
Units

The first option, Units, enables you to select either English or Metric 
units as global measurement units for the CTF878. The selected units 
then become the default settings for every measurement that has the 
option for metric/English units. To select the units, scroll to the Units 
entry on the Meter menu and press [ENTER]. The Meter Settings 
window opens, as shown in Figure 4-2 below.

Figure 4-2: Meter Settings Window

1. Use the  [ ] and [ ] keys to scroll between English and Metric 
units.

2. Press [ENTER] to confirm the choice.

OKCancel
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Entering Date and Time In Operate mode, the Status Bar displays the current date and time 
above the measurements in the upper right corner of the screen. The 
Date/Time option allows you to set the date or time, which are 
required for correct data logging operation. 

To set the time:

1. From the Meter menu, scroll to the Date/Time entry and press 
[ENTER]. The Meter Settings window reopens (see Figure 4-2 on 
page 4-2).

2. From the Units option, press the [ ] key once to reach the date 
text box. This box displays the current meter date. 

3. Press [ENTER] to enter the text window. The meter highlights the 
center number. Use the [  ] and [ ] keys to scroll to any number 
you wish to change.

4. Two alternatives are available to change a highlighted number:

• Use the numeric keys to enter the desired number.

• Use the [ ] or [ ] arrow keys to scroll, in 1-digit increments, 
to the desired number. (For example, if the text box highlights 
09, pressing the [ ] key twice changes the number to 07. You 
can scroll from 01 to 12 for the month and from 01 to 31 for the 
day (depending on the number you have selected for the 
month.) 

In either case, press [ENTER] to confirm the entry.

To enter or change the time:

1. From the time text box, press the [ ] key once to scroll to the 
time text box. This box displays the current meter time. 

2. Press [ENTER] to enter the text box. The meter highlights the first 
number. Use the [ ] and [ ] keys to scroll to any number you 
wish to change.

3. Two alternatives are available to change a highlighted number:

• Use the numeric keys to enter the desired number.

• Use the [ ] or [ ] arrow keys to scroll, in 1-digit increments, 
to the desired number. (For example, if the text box highlights 
09, pressing the  [ ] key twice changes the number to 07.) You 
can scroll from 01 to 12 for the hour and from 01 to 59 for the 
minute and second inputs.

4. In either case, press [ENTER] to confirm the entry.
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Entering Date and Time 
(cont.)

Pressing the [ ] or [ ] arrow keys causes the meter to scroll within 
the Meter Settings options.

• To confirm the entries and return to Operate mode, press [F3] (OK). 
The CTF878 returns to Operate Mode.

• To leave the window without confirming the entries, press [F2] 
(Cancel) or the [ESC] key. The CTF878 returns to Operate Mode.

Changing Date and Time 
Appearance

In addition to setting the correct date and time, you can also change 
its presentation to suit local preferences. You can select a time display 
of AM/PM or 24-hour time.

To alter the time and date display:

1. From the Meter menu, scroll to the Locale tab and press [ENTER]. 
The Display Options window opens on the Locale tab, as shown in 
Figure 4-3 below. To step through each parameter, press the [ ] 
key.

 

Figure 4-3: Display Options Window - Locale Tab
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Changing Date and Time 
Appearance (cont.)

2. The first series of prompts asks you to select separator symbols for 
the date, time and decimal. You can choose from a dash, comma 
and slash (/) for the date; from a period and colon for the time: and 
from a period or comma for the decimal place. For each symbol 
type:

a. Press [ENTER] to open the drop-down menu.

b. Use the [ ] or [ ] arrow keys to scroll to the desired format.

c. Press [ENTER] to confirm your entry.

3. The next prompt asks you to select the date format.

a. Press [ENTER] to open the drop-down menu. Three options are 
available:

• YYYY/MM/DD (year/month/day)

• MM/DD/YYYY (month/day/year)

• DD/MM/YYYY (day/month/year)

b. Use the [ ] or [ ] arrow keys to scroll to the desired format.

c. Press [ENTER] to confirm your entry.

4. The CTF878 now asks you to select whether you want the time 
presented in a 12-hour format (for example, 11:53:23 PM) or in a 
24-hour format (23:53:23).

a. Press [ENTER] to open the drop-down menu.

b. Use the [ ] or [ ] arrow keys to scroll to the 12-hour or 
24-hour entry.

c. Press [ENTER] to confirm your entry.

A line at the bottom, the Date/Time, Decimal Formats, displays how 
the format and separator selections will appear on the screen.

Pressing the [ ] arrow key returns the CTF878 to the Locale tab.

• To confirm the entries and return to Operate mode, press [F3] (OK). 
The CTF878 returns to Operate Mode.

• To leave the window without confirming the entries, press [F2] 
(Cancel) or the [ESC] key. The CTF878 returns to Operate Mode.
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Adjusting Contrast For more comfortable viewing in a particular environment, the 
CTF878 enables you to adjust the screen contrast. To adjust the 
screen contrast:

1. From the Meter menu, scroll to the Contrast entry and press 
[ENTER]. The Display Options window opens on the Display tab, as 
shown in Figure 4-4 below. (From the Format tab, press the [ ] 
key to move to the Display tab.) To step through each parameter, 
press the [ ] key.

Figure 4-4: Display Options Window - Display Tab

2. Scroll to the Darker or Lighter box as desired.

3. Press the [ENTER] button repeatedly until the screen has the desired 
contrast. 

Note: If you find the screen has become too light or too dark, scroll 
to the other box and press [ENTER] until you have adjusted the 
screen to your satisfaction.

• To confirm the entries and return to Operate Mode, press [F3] 
(OK). The CTF878 returns to Operate Mode.

• To leave the window without confirming the entries, press [F2] 
(Cancel) or the [ESC] key. The CTF878 returns to Operate Mode.

Locale

OKCancel

Backlight Off

Language English

Darker

Lighter

Min1

Display Options
Display
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Setting Backlight 
Timeout

By using the Backlight Timeout option, you can set a specified time 
that the CTF878 backlight will remain on before turning itself off.

To set the backlight timeout:

1. From the Meter menu, scroll to the Backlight entry and press 
[ENTER]. The Display Options window opens on the Display tab, as 
shown in Figure 4-4 on page 4-6.

2. Press the [ ] key three times to reach the Backlight Off text box. 

3. Then press [ENTER] to enter the box.

4. Use the numeric keys to enter the number of minutes that the 
backlight remains on (from 0 to 99).

5. Press [ENTER] to confirm the entry.

• To confirm the entries and return to Operate mode, press [F3] (OK). 
The CTF878 returns to Operate Mode.

• To leave the window without confirming the entries, press [F2] 
(Cancel) or the [ESC] key. The CTF878 returns to Operate Mode.

Note: You can turn the backlight on or off at any time by pressing the 
power switch for 1 second.
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Changing 
Communications 
Parameters

On occasion, you might need to change the parameters by which the 
CTF878 communicates with a PC. While programming, refer to the 
Meter Menu Map, Figure 4-10 on page 4-14.

IMPORTANT: The parameters set here MUST agree with those set 
on the PC, or the devices cannot communicate.

To check or change these parameters:

1. From the Meter menu, scroll to the Communication entry and 
press [ENTER]. The Communications window appears similar to 
Figure 4-5 below. 

Figure 4-5: Communications Window

2. The first prompt asks for the node identification number, which 
can be any number from 1 to 240.

IMPORTANT: Do NOT change the node ID unless instructed by the 
factory.

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the node ID.

c. Press [ENTER] to confirm the entry.
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Changing 
Communications 
Settings (cont.)

3. The program now asks for the baud rate. The default rate is
38400 bps. 

Note: Although numbers from 300 to 115,200 are available, baud 
rates higher than 38,400 are not recommended.

a. Press [ENTER] to open the drop-down menu.

b. Use the [ ] or [ ] arrow keys to scroll to the desired rate.

c. Press [ENTER] to confirm the entry.

4. The next prompt asks for the parity from five options: None, Even, 
Odd, Mark, Space. The default parity is None.

a. Press [ENTER] to open the drop-down menu.

b. Use the [ ] or [ ] arrow keys to scroll to the desired parity.

c. Press [ENTER] to confirm the entry.

5. The next prompt asks you to select either one or two stop bits. The 
default number is 1. Use the  [  ] and [ ] keys to scroll to the 
desired number, and press [ENTER].

6. The final prompt asks you to select either seven or eight data bits. 
The default number is 8. Use the  [  ] and [ ] keys to scroll to 
the desired number, and press [ENTER].

IMPORTANT: Using RS-232 requires the following parameters:

• Baud Rate -- the number selected in Step 3 above
• Parity -- None
• Stop Bits -- 1
• Data Bits -- 8 

• To confirm the entries and return to Operate Mode, press [F3] 
(OK). The CTF878 returns to Operate Mode.

• To leave the window without confirming the entries, press [F2] 
(Cancel) or the [ESC] key. The CTF878 returns to Operate Mode.
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Resetting Forward and 
Reverse Totals

On occasion, it might be necessary to clear and reset the forward and 
reverse totals computed by the Forward and Reverse Totalizers. To 
reset the totals:

1. From the Meter menu, scroll to the Totals entry and press [ENTER]. 
The window now appears similar to Figure 4-6 below.

Figure 4-6: Resetting Totals Menu

2. Use the [ ] or [ ] arrow keys to choose the total to be reset.

3. Press [ENTER] to reset the total(s).

The meter resets the selected total(s) to 0.0 and returns to Operate 
Mode.
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Setting Up User Tables When you program user functions (see page 1-30), you can also 
support them with up to six user tables of non-linear or empirical 
data. To program one or more user tables:

1. From the Meter menu, scroll to the User Tables entry and press 
[ENTER]. The window now appears similar to Figure 4-7 below.

Figure 4-7: User Tables Window

2. The first prompt asks you to select the table to be programmed.

a. Press [ENTER] to open the drop-down menu.

b. Use the [ ] or [ ] arrow keys to scroll to the table you wish 
to program.

c. Press [ENTER] to confirm the entry.

OKCancel

UserTable1
Table

Table ID
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Edit Tables
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Setting Up User Tables 
(cont.)

3. The next step is to create a Table ID.

a. Press [ENTER] to open the window. The screen now appears 
similar to Figure 4-8 below.

Figure 4-8: Text Creation Window

b. Use the four arrow keys to scroll to the desired letter or 
symbol, and press [ENTER] to add the letter to the label.

Note:  Pressing [SEL] causes the screen to alternate between a set of 
upper-case (capital) letters and a set of symbols. Use both 
screens to create the desired label.

c. Repeat this procedure for each letter or symbol you wish to add 
to the label (up to a total of fourteen characters). If you wish to 
delete a letter, press [F1] (Delete) to erase each letter or symbol, 
from right to left on the label.

d. When you have completed the label, press [F3] (OK) to confirm 
the label, or [F2] (Cancel) to leave the window without adding 
the label.

Note: It is not necessary to enter the “# Data Points” or “Max 
Points” text boxes.
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Setting Up User Tables 
(cont.)

4. The final prompt asks you to enter or change data in the user table.

a. Press [ENTER] to open the window. The screen appears similar 
to Figure 4-9 below.

Figure 4-9: Edit User Table Window

b. Use the four arrow keys to move to the desired entry in the 
table. 

c. Press [ENTER]. Then use the numeric keys to enter the desired 
data, which appears in the right corner of the window above the 
table.

d. Press [ENTER] to confirm the data, which then appears in the 
appropriate cell in the table.

e. Repeat steps b, c and d until you have completed entering data 
for the table.

f. When you have finished, press [F3] (OK) to confirm the entries 
or [F2] (Cancel) to leave the window without confirming the 
table.

The program returns to the User Functions Tables window. 

• To confirm the entries and return to Operate Mode, press [F3] 
(OK). The CTF878 returns to Operate Mode.

• To leave the window without confirming the entries, press [F2] 
(Cancel) or the [ESC] key. The CTF878 returns to Operate Mode.
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Figure 4-10: Meter Menu Map
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Introduction A powerful and flexible feature of the CTF878 is data logging. The 
meter enables you to choose up to 12 parameters to log. You can also 
select the start time and date, end time and date, and time interval. 
Logs can run one at a time or simultaneously. Error and circular logs 
are also available. The logged data is internally stored in battery-
backed-up memory. A fixed amount of memory is assigned to data 
logging. The frequency of the time interval, the length of the log run, 
and the number of logs affect the amount of memory required for a 
particular log. For example, a log that records every 5 seconds will 
use up more memory than a log that records every 5 minutes for a 
given amount of time. Once you make your data logging selections, 
the CTF878 enables you to view the amount of memory left. You may 
also stop logging or view logged data while or after data is logged.

This chapter describes:

• How to enter the Logging Menu.

• How to set up a new log.

• How to view the data logger memory.

• How to start, stop or pause logging

Entering the Logging 
Menu

To enter the Logging Menu, press the [MENU] key at the lower right of 
the CTF878 keypad. The Main Menu replaces the Status Bar at the 
top of the screen. Use the [ ] arrow key to scroll to the Logging 
Menu. At the Logging Menu, press [ENTER]. The screen appears 
similar to Figure 5-1 below. Refer to the Logging Menu Map, 
Figure 5-18 on page 5-19.

Figure 5-1: Logging Menu
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Site    Program    Meter    Logging    Service

New Log

Logging
Log ManagerVolume, m/s
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Entering the Logging 
Menu (cont.)

To scroll to a particular option, press the [ ] or [ ] arrow key until 
you reach the option. Then press [ENTER] to open the option window.

When entering parameters in an option, press:

• The  [  ] key to step through the available parameters 

• The [ ] key to scroll back to a previously entered parameter

• The [F2] key (Cancel) or the [ESC] key to exit an option at any time 
and return to Operate Mode without changing the parameters.

Log Manager The Log Manager offers users a way to check the status and memory 
size of all the logs currently pending, running or finished. To select 
Log Manager, scroll to the Log Manager entry on the Logging Menu 
and press [ENTER]. If no logs have been entered, the screen appears 
similar to Figure 5-2 below. If logs have been entered, the right 
section of the screen supplies information for a log highlighted on the 
left. Use the [ ] and [ ] arrow keys to scroll to a particular log and 
display information pertaining to that log.

Figure 5-2: Log Manager Window

To access the menu for the Log Manager, press the [MENU] key. The 
cursor highlights the File Menu in the upper left corner. Use the [  ] 
and [ ] keys to scroll to the desired menu, and press [ENTER] to open 
the menu.

ExitRefresh

File   Log   View   Sort

Info

*** NO FILES ***
112128 bytes free

Log Manager

AAA
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File Menu The File menu enables you not only to create new logs, but also to 
clone, rename, delete, refresh, or print existing logs. To open the File 
Menu from the Log Manager, press the [MENU] key and then [ENTER]. 
The screen appears similar to Figure 5-3 below.

Figure 5-3: File Menu in the Log Manager
ExitRefresh

File   Log   View   Sort

o

* NO FILES ***
232 bytes free
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Delete
Delete All Logs?

Print

Refresh

Log Manager
File
New
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Setting up a New Log The New Log option enables you to create and set up parameters for a 
new log. You can access this option in two ways:

• by scrolling to the New Log option in the Logging Menu (as 
shown in Figure 5-1 on page 5-1) and pressing [ENTER], or

• by scrolling to the New option in the File Menu of the Log 
Manager (see Figure 5-3 on page 5-3) and pressing [ENTER].

In either case, the Create New Log screen appears similar to
Figure 5-4 below. Use the four arrow keys to scroll to the desired 
letter or number, and press [ENTER]. Repeat this procedure until you 
have created the desired log name (up to a total of eight characters). 
Press [F1] (Delete) to remove any unwanted letters or numbers. When 
you have finished, press [F3] (OK) to confirm the entry.

Figure 5-4: New Log Window

The CTF878 now asks for log formatting and measurements. The 
screen appears similar to Figure 5-5 on page 5-5.
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Entering General 
Information

Figure 5-5: General Log Format Window

To step through each parameter, press the [ ] key.

1. The first prompt asks you to choose between a linear or circular 
format for the log.

Note: A linear log automatically stops when the meter runs out of 
memory or the specified End time is reached. A circular log 
runs continuously until manually stopped, but only the data 
from the most recent log cycle is saved.

a. Use the [ ] and [ ] keys to scroll to the appropriate radio 
button.

b. Press [ENTER] to confirm your selection.

2. The next prompt asks you to choose whether the log is to be a 
standard or error log. 

Note: A standard log is used to log up to three of the available 
measurement data parameters. An error log is used to log any 
generated error messages.

a. Use the  [ ] and [ ] keys to scroll to the appropriate radio 
button.

b. Press [ENTER] to confirm your selection.

Measurements
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End

Start

ActivateCancel
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Error
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Entering General 
Information (cont.)

3. The next prompt asks for the starting date and time.

a. Press [ENTER] to enter the text box. The meter highlights the 
first number. Use the [ ] and [ ] keys to scroll to any number 
you wish to change, or the  [ ] key to scroll to the time box.

b. Use the numeric keys to enter the desired number.
                                          or
Use the [ ] or [ ] arrow keys to scroll, in 1-digit increments, 
to the desired number. (For example, if the text box displays 
09, pressing the [ ] key twice changes the number to 07.) 
Scroll from 01 to 12 for the month and from 01 to 31 for the 
day (depending on the number selected for the month).

c. In either case, press [ENTER] to confirm the entry.

4. Follow the same procedure to enter the end date and time.

Note: A circular log does not have an end time, but a number of 
records. If you select a circular log, Number of Records 
replaces End. To edit the number of records, scroll to Number 
of Records and press [ENTER]. Type the value for that 
parameter and press [ENTER] again.

5. The final prompt in this window asks for the logging interval.

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the desired interval in seconds. 

c. Press [ENTER] to confirm the entry.

6. You have completed entering parameters in this window. To select 
the measurements, 

a. Press the  [ ] key to return to the Format prompt.

b. Then press the [ ] key to return to the General tab.

c. Finally, press the [ ] key to move to the Measurements tab, 
and press [ENTER]. The Measurements window appears similar 
to Figure 5-7 on page 5-7.

To step through each entry, press the [ ] key.
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Entering Measurements 1. Press [ENTER] to open the first entry. The Select Measurement 
window opens, as shown in Figure 5-6 below.

Figure 5-6: Select Measurement Window

2. Scroll to the desired output type.

3. Press [SEL] to confirm your selection.

4. The prompt then moves to a list of unit types or to a list of 
diagnostic parameters if the DIAG category is shown. Scroll to the 
desired output unit or diagnostic parameter.

5. Press [F3] (OK) to confirm your selection. A screen similar to 
Figure 5-7 appears.

Figure 5-7: Measurements and Units Selected
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Entering Measurements 
(cont.)

6. You can repeat this procedure for up to 12 different parameters. 

7. When you have finished, press [F2] (Cancel) to cancel the entries, 
or [F3] (Activate) to confirm the entries and start the log.

If you started the log from the New Log option, the CTF878 returns to 
Operate Mode, with a Pencil icon (with marks) in the System Tray 
(see Figure 5-8 below). If you started it from within the Log Manager, 
the meter returns to the Log Manager.

Figure 5-8: Operate Mode After New Log Entry
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Copying (Cloning) a 
Selected Log

In the Clone Selected Log option, you can copy the parameters of a 
particular log, modify the parameters, and start the copy. To copy a 
log:

1. First, select the log you wish to copy in the Log Manager (see 
Figure 5-2 on page 5-2).

2. Then press [MENU], open the File Menu, scroll to the Clone 
Selected Log option, and press [ENTER].

3. The Create New Log window (shown in Figure 5-4 on page 5-4) 
opens. Follow the procedure discussed on page 5-4 to create a log 
name, and press [F3] (OK) to confirm the name.

4. The General Log Format window (see Figure 5-5 on page 5-5) 
opens. Follow the procedure which begins on page 5-5 to change 
any settings. 

Note: Unless otherwise specified, the cloned log always begins at 
the current date and time, and ends after the period of time 
used by the original log.

5. If you wish, scroll to the Select Measurements window (see 
Figure 5-6 on page 5-7) and follow the procedure discussed on 
page 5-7 to modify any parameters. 

6. When you have completed modifying the log parameters, press 
[F2] (Cancel) to cancel the log or [F3] (Activate) to confirm and 
start the new log.

The CTF878 returns to the Log Manager, which now displays the 
status of the cloned log.

Renaming a Log To rename a log:

1. First, select the log you wish to rename in the Log Manager 
(shown in Figure 5-2 on page 5-2).

2. Then open the File Menu, scroll to the Rename option, and press 
[ENTER].

3. The Rename Log window opens. (Except for the heading, the 
window is identical to the Create New Log window shown in 
Figure 5-4 on page 5-4.) Follow the procedure discussed on 
page 5-4 to create a log name, and press [F3] (OK) to confirm the 
name.

The CTF878 returns to the Log Manager, which highlights the 
renamed log.
Logging Data 5-9



February 2007
Deleting a Log To delete a log:

1.  First, select the log you wish to delete in the Log Manager (shown 
in Figure 5-2 on page 5-2).

2. Then open the File Menu, scroll to the Delete option, and press 
[ENTER].

3. A delete confirmation window opens, as shown in Figure 5-9 
below. Press [F2] (No) to stop the deletion, or [F3] (Yes) to delete 
the log.

The Log Manager reappears, with the specified log deleted.

Figure 5-9: Delete Confirmation Window

Deleting All Logs To clear the Log Manager and memory of all logs, open the File 
menu, scroll to the Delete All Logs option, and press [ENTER]. A 
window opens, asking, “Delete All Logs?”

• Press [F2] (No) to stop the deletion, or 

• Press [F3] (Yes) to delete the logs. A blank Log Manager 
appears. All logs have been deleted.

Refreshing the Log 
Manager Screen

To refresh the Log Manager screen and view the most recent 
information on a given log, select the log you wish to view in the Log 
Manager. Then open the File Menu, scroll to the Refresh option, and 
press [ENTER]. The screen momentarily blanks, and then reappears 
with the most current information on the highlighted log.

   

YesNo

File     Log     View     Sort

Delete Log '555.LOG?'

Log Manager
Delete
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Log Menu The Log Menu allows you to pause, restart or end any or all logs that 
are currently pending or running. (However, you cannot restart any 
finished logs, even if they were finished before the programmed end 
time.) To open the Log Menu in the Log Manager, press [MENU]. 
Scroll to the Log option, and press [ENTER]. The window appears 
similar to Figure 5-10 below.

Figure 5-10: Log Menu in the Log Manager

Stopping (Pausing) a Log To stop a log that is currently pending or running, 

1.  First, select the log you wish to pause in the Log Manager (shown 
in Figure 5-2 on page 5-2).

2. Then open the Log Menu, scroll to the Pause option, and press 
[ENTER].

The CTF878 returns to the Log Manager, which displays the 
highlighted log with “Paused” in the State line.

Restarting a Log To restart a paused log:

1.  First, select the log you wish to restart in the Log Manager 
(shown in Figure 5-2 on page 5-2).

2. Then open the Log Menu, scroll to the Start option, and press 
[ENTER].

The CTF878 returns to the Log Manager, which displays the 
highlighted log with a status of “Pending” or “Running.”

ExitRefresh
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Ending a Log To end a log:

1.  First, select the log you wish to end in the Log Manager (shown in 
Figure 5-2 on page 5-2).

2. Then open the Log Menu, scroll to the End option, and press 
[ENTER].

The CTF878 returns to the Log Manager, which displays the 
highlighted log with a status of  “Finished.” The space not used by the 
finished log is freed for reuse.

Note: You cannot restart a finished log. You must create a new log 
with the same parameters.

Stopping All Logs To stop all logs that are currently pending or running, open the Log 
Menu, scroll to the Pause All Logs option, and press [ENTER]. The 
CTF878 returns to the Log Manager, which displays all logs 
programmed to run now or in the future with a status of “Paused.”

Restarting All Logs To restart all paused logs, open the Log Menu, scroll to the Start All 
Logs option, and press [ENTER]. The CTF878 returns to the Log 
Manager, which displays the logs with a status of “Pending” or 
“Running.”

Ending All Logs To end all currently pending or running logs, open the Log Menu, 
scroll to the End All Logs option, and press [ENTER].The CTF878 
returns to the Log Manager, which displays the running logs with a 
status of  “Finished.”

View All Sites To check on all logs, open the Log Menu, scroll to the View All Sites 
option, and press [ENTER]. Logs are associated with the site in use at 
the time the log is created. Thus, when another site is in use, the 
CTF878 automatically starts different logs. By default, the Log 
Manager only displays the logs created with the current site. View All 
Sites allows the Manager to list logs for all sites.
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View Menu Through the View menu, you can view the data of individual logs in 
graphical or spreadsheet formats. To open the View menu from the 
Log Manager, press [MENU]. Scroll to the View menu, and press 
[ENTER]. The screen appears similar to Figure 5-11 below.

Figure 5-11: View Menu

Displaying Log Details To view details of a given log, be sure the log is highlighted in the left 
window of the Log Manager. Then scroll to the View menu and press 
[ENTER]. Scroll to the Details option and press [ENTER]. The screen 
now appears similar to Figure 5-12 below.

Figure 5-12: Log Details Display Window

Press [F2] (Cancel) or [F3] (OK) to return to the Log Manager.

ExitRefresh
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Displaying Log Data in 
Graphical Form

To view a log in graphical format, be sure the log is highlighted in the 
left window of the Log Manager. Then scroll to the View menu and 
press [ENTER]. Scroll to the Graph option and press [ENTER].

Figure 5-13: Log Graph Display Window

The Select Measurement window opens and lists the log 
measurement parameters. If a log contains more than one 
measurement, you must select which measurement to plot from the 
list displayed. Once you have chosen the measurement parameter, 
press [F3] (View). The screen now appears similar to Figure 5-13 
above. Press [F2] (Cancel) to leave the window without viewing the 
graph.

• If you wish to alter the graph scale, press [F1] (Scale) and go to 
page 5-15. 

• If you wish to alter the time scale, press [F2] (Time) and go to 
page 5-16. 

• To leave the window, press [F3] (Exit).

Exit
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TimeScale

LOG02A (Velocity, m/s)
5-14 Logging Data



February 2007
Displaying Log Data in 
Graphical Form (cont.)

Figure 5-14: Y-Axis Window

The Y-Axis window (shown in Figure 5-14 above) allows you to 
specify whether the Y axis on the graph extends to the maximum 
value (Max), over the entire range (Range) or between certain 
specified values (Set).

1. Use the [ ] and [ ] keys to scroll to the desired limit type. Press 
[ENTER] to confirm the entry.

If you select Max or Range for limits, you have finished entering data 
in this form. But if you select Set, the CTF878 asks for minimum and 
maximum limits.

2. Press the  [ ] key to reach the Minimum text box.

a. Press [ENTER] to open the text box.
b. Use the numeric keys to enter the desired value.
c. Press [ENTER] to confirm the entry.

3. Repeat step 2 to enter the Maximum value.

4. When you have finished, press [F2] (Cancel) to cancel the entries, 
or [F3] (OK) to confirm the entries and change the graph.

OKCancel

Max Set
Limits

Minimum 0.1234

Maximum 0.1234

03/03/01
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03/03/01
13:53:41 PM

Y-Axis

Range
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Displaying Log Data in 
Graphical Form (cont.)

If you wish to alter the time scale, press [F2] (Time). The Enter Time 
window appears similar to Figure 5-15 below.

Figure 5-15: Enter Time Window

1. Use the arrow keys to scroll to the desired text box. Press [ENTER] 
to open the box.

2. Use the numeric keys to enter the desired number.
                                            or
Use the [ ] or [ ] arrow keys to scroll, in 1-digit increments, to 
the desired number. (For example, if the text box displays 09, 
pressing the  [ ] key twice changes the number to 07.) Scroll 
from 01 to 12 for the month, from 01 to 31 for the day (depending 
on the number selected for the month), and from 0 to 59 for 
minutes and seconds.

3. In either case, press [ENTER] to confirm the entry.

4. Repeat step 2 for any other entries you wish to change.

When you have finished, press [F3] (OK) to confirm the entries and 
close the window, or press [F2] (Cancel) to leave the window without 
changing the entries.
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Displaying Log Data in 
Spreadsheet Form

To view a log in spreadsheet form, be sure the log is highlighted in the 
left window of the Log Manager. Then scroll to the View menu and 
press [ENTER]. Scroll to the Spreadsheet option and press [ENTER]. The 
screen now appears similar to Figure 5-16 below.

Figure 5-16: Log Spreadsheet Window

Use the [ ] and [ ] keys to scroll to other columns, or the [ ] or 
[ ] keys to scroll backward or forward in time.

• To alter the times displayed, press [F1] (Time). The Enter Time 
window (shown on the previous page) opens. Follow the 
instructions on the previous page to change the date or time.

• To refresh the display, press [F2] (Refresh). The display shows the 
most current data.

• Press [F3] (Exit) to return to the Log Manager.
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Sort Menu The Sort Menu within the Log Manager allows you to arrange your 
log list either alphabetically (By Name) or chronologically (By Date).

Figure 5-17: Sort Menu in the Log Manager

Listing Logs by Name If you want to list your logs alphabetically by log name within the 
Log Manager, press [MENU] to open the File Menu. Then scroll from 
the File Menu to the Sort Menu, scroll to the By Name option (see 
Figure 5-17 above), and press [ENTER]. The Log Manager screen 
refreshes, with the sites listed in alphabetical order.

Listing Logs in 
Chronological Order

If you prefer to list your logs chronologically by time of creation 
within the Log Manager, press [MENU] to open the File Menu. Then 
scroll from the File Menu to the Sort Menu, scroll to the By Date 
option, and press [ENTER]. The Log Manager screen refreshes, with 
the sites listed in chronological order, from the most recent to the 
earliest.

ExitRefresh

File   Log   View   Sort

2.LOG
nished

E:03/01/01 13:13:41
E:03/01/01 13:23:41
Interval: 10 Seconds
Records:51

03/01/01 13:23:21
1216 bytes
109568 bytes free

By DateLOG02A
LOG02

Log Manager
Sort
> By Name
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Figure 5-18: Logging Menu Map
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TÜV ESSEN
ISO 9001

U.S.

TÜV

We, Panametrics Limited
      Shannon Industrial Estate

       Shannon, County Clare
    Ireland

declare under our sole responsibility that the

CTF878 Ultrasonic Flowmeter

to which this declaration relates, are in conformity with the following standards:

• EN 61326:1998, Class A, Annex A, Continuous Unmonitored Operation

• EN 61010-1:1993 + A2:1995, Overvoltage Category II, Pollution Degree 2

following the provisions of the 89/336/EEC EMC Directive and the 73/23/EEC Low Voltage Directive.

Shannon - April 15, 2004
Mr. James Gibson

GENERAL MANAGER
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TÜV ESSEN
ISO 9001

U.S.

TÜV

Nous, Panametrics Limited
      Shannon Industrial Estate

       Shannon, County Clare
    Ireland

déclarons sous notre propre responsabilité que les

CTF878 Ultrasonic Flowmeter

rélatif á cette déclaration, sont en conformité avec les documents suivants:

• EN 61326:1998, Class A, Annex A, Continuous Unmonitored Operation

• EN 61010-1:1993 + A2:1995, Overvoltage Category II, Pollution Degree 2

suivant les régles de la Directive de Compatibilité Electromagnétique 89/336/EEC et de la Directive Basse Tension 
73/23/EEC.

Shannon - April 15, 2004
Mr. James Gibson

DIRECTEUR GÉNÉRAL
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TÜV

Wir, Panametrics Limited
      Shannon Industrial Estate

       Shannon, County Clare
    Ireland

erklären, in alleiniger Verantwortung, daß die Produkte

CTF878 Ultrasonic Flowmeter

folgende Normen erfüllen:

• EN 61326:1998, Class A, Annex A, Continuous Unmonitored Operation

• EN 61010-1:1993 + A2:1995, Overvoltage Category II, Pollution Degree 2

gemäß den Europäischen Richtlinien, Niederspannungsrichtlinie Nr.: 73/23/EG und EMV-Richtlinie Nr.: 89/336/EG.

Shannon - April 15, 2004
Mr. James Gibson

GENERALDIREKTOR
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